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Portfolio Project Sync

Portfolio Project Sync is an innovative technology 
that enables a connection between Portfolio 
Server and Version Cue Server. It is through this 
connection that Adobe Creative Suite users are able 
to tap into the powerful asset sharing and archiving 
capabilities of Portfolio Server, all without ever 
opening a Portfolio catalog. 

By integrating Portfolio Project Sync into the 
creative work�ow, users can access and save 
assets in a manner to which they�re already 
accustomed. Creative users can stay in Creative Suite 
applications, and others can access assets through a 
variety of methods � through the Express palette, a 
NetPublish site, or directly with the Portfolio client. 
By allowing this level of access, Portfolio doesn�t 
dictate the way that you want your team to work, 
you do.

Typical usage

Through Portfolio Project Sync, Portfolio Server 
effectively becomes the hub of your asset 
management and distribution system. 

By utilizing metadata extracted from your �les, �les 
are easily located. Creative users can input custom 
XMP metadata through the Adobe File Info dialog, 
and have that data used to help others locate assets. 

Following are a few common ways that Portfolio 
Project Sync is implemented. 

Project Sync as a graphics library
A common use of Portfolio Project Sync is to provide 
an avenue for creative users to obtain graphics 
required to build other projects. For example, a 
creative user who works mainly with Adobe Creative 
Suite applications, can access items such as logos, 
templates, and other graphic elements directly from 
the �le menu in Adobe Creative Suite applications. 
Users can also browse directly to assets stored in 
Portfolio Server catalogs by using Adobe Bridge to 
obtain the item that they need. 

For this type of use, the creative user might not ever 
need to launch the Portfolio client, and may choose 
to work entirely within Adobe Bridge to locate 
necessary assets for their projects. 

Introducing Portfolio Project Sync
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As an archival server
When creative projects are complete, the �nal 
�les need to reside in a secure location. Users can 
work in standard Version Cue projects that utilize 
versioning, check in and check out functionality, 
and then using Portfolio Project Sync, users can 
copy the �les to a Portfolio archive catalog folder 
directly from the Adobe Save dialog box of most 
Creative Suite applications, or drag to copy them in 
Bridge.  

As a web-based distribution system
Project Sync can be a gateway from the creative 
workgroup to the world wide web. When used in 
conjunction with Portfolio NetPublish, �les created 
and maintained in Creative Suite applications can 
be instantly published to the web with little or no 
user interaction. 

In this instance, creative users work as they 
normally do in their Creative Suite applications. 
Any �les that they output and save into a Project 
Sync project pre-con�gured with NetPublish are 
immediately published to the web. Portfolio Server 
can even generate low-res previews of most �le types 
for web users. This allows anyone with a standard 
web browser to access, preview and download the 
�nished assets.

As a self-service distribution system for  
non-creative users

For everyone in the organization, particularly 
non-Creative Suite users who might need access 
to creative assets such as logos, templates, 
presentations and so forth, Portfolio Server can 
provide access to assets through Portfolio Express 
or the Portfolio client. Both applications place 
cataloged assets at users �ngertips, freeing creatives 
from servicing requests for �les.

So the creative team creates the asset and saves 
it into a Project Sync project. The non-creative 
user is then able to locate and drag the asset out 
of Portfolio Express directly into almost any new 
document of their choice. 
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System Requirements

Server System Requirements

The following are the minimum system 
requirements to install and con�gure Portfolio 
Project Sync� for use with Adobe Version Cuefi 
Server.

End user system requirements

The following are the minimum system 
requirements for end users of Project Sync projects.

All end users must connect to Portfolio Project Sync 
projects with Adobe CS3 applications. Previous 
versions of Creative Suite applications are not 
supported.

Due to the design of Version Cue and Bridge, it�s 
important to note that as �les are used, the �les are 
cached on the end user�s system. This can require a 
signi�cant amount of hard drive space depending 
upon the number and size of �les being accessed. 

Server installation overview

1.	Install Version Cue Server

2.	Install Portfolio Project Sync

3.	Update Version Cue settings and restart the  
Version Cue Server

4.	Install Portfolio Server

5.	Install Portfolio client

6.	Create a new served catalog

7.	Create at least one AutoSync watch folder

8.	Con�gure Portfolio and Version Cue users

9. 	Con�gure Portfolio Project Sync 

Installing and Configuring  
Portfolio Project Sync 



4

User Guide Portfolio Project Sync

Install Version Cue server

Version Cue exists as two components - the Version 
Cue Server as well as the client component which is 
built into Adobe CS3 applications. 

Install Adobe Version Cue Server on your server 
before installing Portfolio Server. A custom 
Adobe Creative Suite installation is required to 
install Version Cue Server. Please see your Adobe 
installation instructions for complete details.

The Project Sync software is a plug-in is for a Version 
Cue Server and is not designed for installation on 
end-users� systems. You only need install it once at 
the server level. 

Install Portfolio Project Sync 

To install Project Sync, run the installer on the 
Version Cue Server machine. This installer places 
the plug-in in the appropriate location as follows: 

Plug-in location on a Mac OS X Server:

/Library/Application Support/Adobe/Adobe 
Version Cue CS3/Server/plugins/ 
com.extensis.portfolio.projectsync _ 1.0.0/

Plug-in on a Microsoft Windows Server:

<system drive>\Program Files\ 
Common Files\Adobe\Adobe Version Cue CS3\ 
Server\plugins\com.extensis.portfolio.
projectsync _ 1.0.0/ 

Update Version Cue settings and 
restart the Version Cue Server

After installing Portfolio Project Sync, you must 
update a few system settings and restart the Version 
Cue server.

On a Mac OS X Server:

1.	Choose the Apple Menu > System Preferences > 
Version Cue CS3 icon

2.	If necessary click the lock in the lower lefthand corner 
and authenticate to enable changes.

3.	From the Settings tab, set the Server Visibility option 
to Visible to Others

4.	Set the Workgroup Size option to your desired 
workgroup size. 

5.	Enable the Turn On Server When the Computer 
Starts option.

6.	Click the Apply Now button.

7.	Click the Stop button.
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8.	Click the Start button.

9.	Close the System Preferences.

On a Microsoft Windows Server:

Adobe Version Cue Server runs as a service on  
Microsoft Windows. To update the Version Cue 
service preferences:

1.	Choose Start > Control Panel >  
Adobe Version Cue CS3 

2.	From the Setting tab, set the Server Visibility option 
to Visible to Others

3.	Set the Workgroup Size option to your desired 
workgroup size. 

4.	Enable the Turn On Server When the Computer 
Starts option.

5.	Click the Stop button.

6.	Click the Start button.

Install the Portfolio Server

If you haven�t done so already, install  
Portfolio Server. 

Install the Portfolio Client

Install the Portfolio Client on the Server machine. 
You will create your AutoSync folders directly on the 
Server with the Portfolio client. 

Create a catalog 

In Portfolio Server, create a new served catalog. 
Extensis recommends that you create an entirely 
new catalog for use with Portfolio Project Sync. 

Choose the Portfolio Project Sync™ for Adobe® 
Creative Suite catalog type for maximum data 
compatibility during catalog creation. 

If you choose to upgrade an existing catalog, see 
the Portfolio Server User Guide for details about 
upgrading. 

1.	From a Portfolio Client, choose File >  
Administer Server.

2.	To add your new Portfolio Server to the list. Click the 
Add Server button. Enter a name for your server and 
the server�s IP address. Click OK.

2.	In the Administer Servers dialog box, choose the 
server name and click Administer.

3.	Enter the password for the catalog. If one does not 
exist, enter a new password.

4.	In the Administration dialog box, click New to create 
a new catalog.

5.	Choose the Portfolio Project Sync™ for Adobe® 
Creative Suite catalog type and click OK. 

For additional Portfolio Server catalog con�guration 
options, see the Portfolio Server User Guide.
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Create an AutoSync watch folder

Only AutoSync watch folders can be accessed 
through Version Cue clients using Portfolio Project 
Sync. This is to due to the fact that Portfolio 
catalogs can span across multiple �le systems and 
also include of�ine assets. To ensure that all assets 
are actually available to users when they connect 
through Project Sync, only AutoSync watch folders 
are accessible through the Adobe Version Cue 
interface.

When you are con�guring AutoSync watch folders, 
it may be helpful to think of each watch folder as a 
separate project. This way AutoSync folders can be 
enabled as projects separately in Project Sync. This 
isolates individual projects, yet makes them easily 
searchable in the Portfolio client.

So, after creating a new catalog, the next step is to 
select a location and add an AutoSync folder. This 
folder is where all of your original assets will be 
stored.

The location of the AutoSync folder need not be 
on the same server as the Portfolio Server or the 
Version Cue Server. The Portfolio Server must have 
read/write privileges to the AutoSync folder location, 
but the end users of the catalog need not have direct 
access. All access will be provided through Portfolio 
and Adobe Version Cue Server.

To create an AutoSync watch folder:

1.	If you haven�t already done so, install the Portfolio 
Client on the same machine as the Portfolio Server. 
The AutoSync watch folder must be added to the 
catalog by a client being directly run on the Portfolio 
Server machine, and not by any other client remotely.

2.	Choose Catalog > Access Level and in the Access 
Level dialog box, choose Admin level access. Enter 
the appropriate password for your catalog. 

3. In the Folder View pane/drawer, click the Add Watch 
Folder button  

4. Navigate to the folder you want add as an AutoSync 
folder, and click OK. 

3.	In the AutoSync Settings dialog choose options as you 
would normally for any other AutoSync folder. 

	 For optimum performance, Extensis recommends 
that the AutoSync watch folder settings for use with 
Portfolio Project Sync be set to:

	 See the Portfolio Server User Guide for complete 
AutoSync folder settings details. 
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4.	Click OK to add the AutoSync folder. 

5.	If prompted, navigate to the appropriate network 

share and click OK. 

Con�gure Portfolio and  
Version Cue users

In this step, you will con�gure both your Portfolio 
Catalog users and Version Cue users. 

Project Sync user access options
Before you set up your Portfolio and Version Cue 
user accounts, it�s important to understand the two 
different access options available when you create a 
Portfolio Project Sync project. 

Which option you choose depends upon the type 
of Portfolio catalog access setting that you are using 
� either User-based Access or Level-based Access.

Catalogs that use Level-based Access can only allow 
full access for all users. Catalogs that use User-based 
Access can use either Project Sync access option.  

So, if you think that you�ll need to control access 
to your Project Sync projects, you�ll want to use 
User-based access. Since Project Sync projects are 
con�gured on a per-folder basis, you can still allow 
access to any single folder within a catalog. 

Before you can set up the project, you must 
con�gure your Version Cue users and the user  
access type in the Portfolio catalog. 

Con�gure Version Cue Users
It�s important to note that the Version Cue Users 
and Portfolio Users are entirely different from each 
other. Every user will need a Version Cue username 
and password to access the Version Cue Server, 
regardless of your catalog�s access setting. 

Follow the instructions contained in the Adobe 
Help to con�gure Version Cue user names for all 
of your users. If you also plan to implement User-
based access to your Portfolio catalog, be sure to 
make a list of all of the user names so that they can 
be identically created in the Portfolio catalog. Users 
will only need to authenticate to the Version Cue 
Server.

Con�guring a catalog to use  
User-based Access

User-based Access for Portfolio catalogs allows the 
most control over how Version Cue users access 
assets from Project Sync projects. 

Each user�s access to assets is determined by their 
access level in the catalog. This allows you to 
designate some users with limited access, while 
others will have full control. 

See the chart on the next page for access details.

To implement User-based access:

1.	From the Portfolio client, in Administrator mode,  
open the speci�ed Portfolio Catalog and choose 
Catalog > Administration.
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2.	From the Passwords tab, select the User-based 
Access option and click the Edit User Access button.

3.	In the Users dialog box, click New and add new 
users. 

4.	Enter a user name and password for the account. If 
you use matching username and passwords that you 
con�gured for Version Cue, users will only need to 
authenticate to Version Cue to access Project Sync 
assets. 

	 While Version Cue and Portfolio user names must 
be identical, passwords for these accounts may be 
different. 

	 Choose an access level based on what level of 
functionality you want available to this user. See the 
chart on this page for details.

5.	Click OK to add the new user. Repeat the process for 
each of your users as required. 

Con�guring a catalog to use 
Level-based Access

If you are using Level-based access to your Portfolio 
catalog, users will only need to authenticate to the 
Version Cue Server to access Project Sync projects. 

This method of access is the least secure, but allows 
all Version Cue users a great deal of power to 
explore and modify assets. The level-based access 
method basically allows all users Administrative 
level (full read/write/delete) access to assets through 
Version Cue, and should be implemented only in 
environments where this is considered acceptable.

Actions available to users in catalogs with User-based Access

Reader Editor Publisher Administrator

Explore Assets Yes Yes Yes Yes

Synchronize Yes Yes Yes Yes

Search Yes Yes Yes Yes

Copy from Portfolio Yes Yes Yes Yes

Copy to Portfolio No No Yes Yes

Move Assets No No Yes Yes

Delete Assets No No Yes Yes

Add Assets No No Yes Yes
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Con�gure the Project Sync plug-in

The Portfolio Project Sync plug-in is con�gured 
directly through a web interface launched from the 
Version Cue preferences dialog box.

1.	On a Mac OS X Server, choose the Apple Menu > 
System Preferences > Version Cue CS3 icon

	 Or, choose the Version Cue CS3 Server status icon 
from the Finder Menu Bar and choose Version Cue 
CS3 Preferences.

	 On a Microsoft Windows Server, choose Start > 
Control Panel > Adobe Version Cue Server

2.	From the Settings tab, click Server Administration. 
This launches the administration options in your 
default web browser.

3. Enter the Administrator user name and password. If 
this is the �rst time that you�ve ever run the Version 
Cue Server Administration, you�ll be presented with 
some Initial Con�guration options. 

	 For complete Initial Con�guration settings details, 
see the Adobe Version Cue documentation. The 
following are recommendations of settings for use 
with Portfolio Project Sync:

Visible to Others

Manual User Creation

Save and Continue

4.	From the Advanced tab of the Version Cue 
Administration interface, click Plugins Overview.

5.	From the Plugins Overview page, click the Portfolio 
Project Sync link. 
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	 This launches the Portfolio Project Sync 
Administration interface.

6.	In the Portfolio Projects Overview page click the  
New Project link to start a new portfolio project.

7.	From the Connect to Portfolio Server page, enter the 
Portfolio Server IP Address, port and password. 

	 The default Portfolio Server port is 2903.

	 For the Server Password, enter the Portfolio Server 
Administration password. Passwords are not required 
for the speci�c catalogs. 

	 Click Connect to connect to the Portfolio Server.

8.	The New Project page displays the catalogs and 
folders available on the Portfolio Server to which you 
are connected. 

	 In the Catalog drop-down box, choose from the list 
of catalogs on the Portfolio Server. 
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9.	From the Folder drop-down box, choose an AutoSync 
watch folder from the list. 

	 If you do not see any watch folders, close the Project 
Sync window. Go back to the Portfolio Client, add an 
AutoSync watch folder to your catalog, and log back 
in to Project Sync.

10. Choose the enabled option (or deselect it) to toggle 
the project availability to Version Cue users.

11. Add a description.

12. Choose an Access level for the project.

	 Permit only Portfolio users � if you have set up user-
based access for your Portfolio catalogs, Portfolio 
will provide asset change level security based on 
the user�s Portfolio access level. See the chart in this 
chapter for details. 

	 Allow access for all users � As the name indicates, 
this setting will allow all Version Cue users to connect 
to Portfolio Project Sync projects with Read/Write 
access. This is the only option available for Portfolio 
catalogs setup to use the Level-based Access method.

13. Click Add Project to �nish adding the Portfolio 
Project Sync project to Version Cue Server. 

14. Click Logout to exit. 
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Accessing Portfolio Project Sync 
projects through Adobe Bridge

Users connect to Portfolio Project Sync projects 
through Adobe Creative Suite applications that 
support Version Cue. One of the ways of connecting 
is through Adobe Bridge.

1.	Launch Adobe Bridge.

2.	From the Folders Tab, click Version Cue and then 
click Browse Servers

3. From the list, choose your Version Cue Server. Twist 
down the icon to the left of the server name. 

	 When prompted to authenticate to the Version Cue 
Server, enter a Version Cue username and password. 

4.	Browse the Portfolio Project Sync projects on that 
server, and when you choose a project, twist down 
the icon to the left of the project folder. 

	 You may need to choose the Contents tab of the 
center window to view the list of assets.

	 If the Project Sync project is con�gured to Permit 
only Portfolio users, and the Portfolio catalog user 
names are the same as the Version Cue user names, 
then you are automatically allowed into the Project 
Sync project. 

	 If the Portfolio Project Sync project was con�gured 
to Allow access for all users, a Portfolio-level 
authentication is not required, and all Version Cue 
users have read/write access to the Project Sync 
project. 

	 Project Sync projects can now be browsed like any 
other �le system in Adobe Bridge. 

	 For a list of the status indicators and commands 
available in Project Sync projects through Adobe 
Bridge, see the chart at the end of this chapter. 

Working with Project Sync �les through  
Adobe Bridge

Only Check In functionality is available with 
Project Sync projects. Basically, the most recent 
version of the �le checked in is the one stored in 
Portfolio. 

If users require version tracking and the full check 
in/check out functionality of Version Cue, use 
a standard Version Cue project not connected 
to Project Sync. In work�ows that require this 
functionality, Extensis recommends that you use 

Using Portfolio Project Sync
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Project Sync projects as a repository for the �nal 
versions of your assets or as an access point for 
common elements.  

To obtain a local copy of the �le from Portfolio: 

Synchronize from the menu. This downloads the �le 
from Portfolio Server and places a local copy on your 
machine. 

	 � or �

	 Double-click a �le in Adobe Bridge. Opening the �le 
automatically downloads and opens the local copy for 
you. 

When you are �nished editing a �le, that �le isn�t 
automatically saved back to Portfolio Server. You 
need to Check In your local copy to Portfolio Server. 

To Check In the �nal version of a local copy back up  
to Portfolio: 

Check 
In from the menu.

	 � or �

	 With your �le open in any Creative Suite application, 
choose File > Check In to save that version to 
Portfolio. 

Editing Metadata
XMP metadata can be edited directly through Adobe 
Bridge in multiple ways. When you edit a �le�s 
metadata with Bridge, you are directly editing the 
metadata for the �le on the server, so you can edit 
metadata without synchronizing with the server. 

The three methods to edit metadata in Bridge are:

Tools > Create 
Metadata Template 

File > File Info

Accessing Portfolio Project Sync 
projects through the  
Adobe dialog box

Users can access Version Cue projects through many 
Adobe application�s Open and Save dialog boxes. 

1.	From any Adobe application, click Open or Save. 

2.	In the dialog box, click the Use Adobe Dialog 
button. 
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	 If you see the Use OS Dialog button, you are already 
using the Adobe Dialog.

3.	In the left hand column, click Version Cue. 

4.	Twist open the Browse Servers icon. 

5.	From the list, choose your Version Cue Server. Twist 
down the icon to the left of the server name. 

	 When prompted to authenticate to the Version Cue 
Server, enter a Version Cue username and password. 

4.	Browse the Portfolio Project Sync catalogs on that 
server, and when you choose a catalog, twist down 
the icon to the left of the catalog name. 

	 If the Project Sync project is con�gured to Permit 
only Portfolio users, and the Portfolio catalog user 
names are the same as the Version Cue user names, 
then you are automatically allowed into the Project 
Sync project.

	 If the Portfolio Project Sync project was con�gured to 
Allow access for all users, all Version Cue users have 
read/write access to the Project Sync project. 

	 For a list of commands and status indicators in the 
Adobe dialog box, see the chart at the end of this 
chapter.

7.	Browse to the desired �le and click Open. Or, if saving 
a �le, browse to the desired location and click Save.

Launching Portfolio from  
Adobe Bridge

If you have the Portfolio client installed on your 
machine, you can launch the Portfolio client 
directly from Adobe Bridge. 

content window and choose Launch Portfolio 
from the menu. This connects you immediately to 
the served catalog enabled through Project Sync. 
Portfolio prompts you for any required username and 
password.
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